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Using GIS in the study of the hydrographical drainage basins morphometry in the west 
side of The Central Moldavian Tableland. This paper presents some methodological aspects
about using GIS in the study of the geomorphometry of the hydrographical drainage basins
from the west side of The Central Moldavian Tableland. It was applied GIS in the 
cartographic representation and the spatial analysis of the fallow parameters of the relief: 
altitude, slope, exposition, the deep of fragmentation and the density of fragmentation.
Concerning the mentioned parameters, in this region are evident asymmetries between left and 
right versants of the rivers, under the influence of monocline geological structure with north-
west – south-east inclination of rocks.

Studiul parametrilor morfometrici ai bazinelor hidrografice are o importanţă 
deosebită atât din punct de vedere teoretic, prin studiul indicilor morfometrici de bază 
ce pot conduce la concluzii în legătură cu evoluţia reliefului, cât şi practic, prin datele 
furnizate unor domenii social-economice (organizarea teritoriului sau amenajarea 
unor localităţi, agricultură, construcţii de căi de comunicaţie ş.a.). Studiul reliefului cu 
ajutorul SIG prezintă numeroase avantaje arătate de mai mulţi autori în numeroase 
lucrări de specialitate. Analiza la nivel general, a întregii regiuni din vestul Podişului 
Central Moldovenesc, am prezentat-o într-o lucrare anterioară (V. Budui, 2005). În 
lucrarea de faţă vom prezenta metodologia de lucru în SIG pentru analiza 
geomorfometrică a bazinelor hidrografice şi vom exemplifica prin analiza 
comparativă a câtorva bazine hidrografice din cuprinsul acestei regiuni. Poziţia 
matematică a regiunii vestice a Podişului Central Moldovenesc în care am făcut 
aplicaţiile respective este prezentată în figura 1.

Analiza morfometrică a regiunii de studiu s-a bazat, în principal, pe modelul 
numeric al altitudinii (MNA), realizat cu ajutorul programului TNTmips 6.8, la o 
rezoluţie spaţială de 20x20 m, pornind de la curbele de nivel cu echidistanţa de 10 m
vectorizate de pe hărţile topografice 1:50.000, şi, parţial (în luncile râurilor), de la 
curbe cu echidistanţa de 5 m digitizate de pe hărţile topografice la scara 1:25.000. S-
au punctat, de asemenea, mai multe cote cu altitudini maxime ale unor dealuri sau 
altitudini ale confluenţelor unor artere hidrografice. Caracteristicile morfometrice 
principale luate în studiu sunt altitudinea, înclinarea terenului, orientarea versanţilor, 
adâncimea fragmentării reliefului şi densitatea fragmentării reliefului.

Modalitatea de realizare a modelului numeric al reliefului am prezentat-o 
într-o lucrare anterioară (V. Budui, 2004). Algoritmul de lucru pentru realizarea 
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hărţilor derivate direct din MNT este simplu, generarea făcându-se automat în meniul 
Process → Raster → Elevation → Slope, Aspect and Shading.

Reprezentarea 
adâncimii fragmentării 
reliefului şi a densităţii 
fragmentări reliefului 
presupune o prelucrare mai 
laborioasă. Maniera clasică 
de realizare a hărţii este 
transpusă în programul SIG. 
Pentru primul indice se 
calculează mai întâi  
altitudinea maximă şi, 
respectiv, altitudinea minimă
în pătrate cu latura de 1 km 
prin aplicarea unui limbaj de 
programare SML (Spatial 
Manipulation Language -
Limbaj de Manipulare 
Spaţială). Rezultă două 
rastere care conţin pixeli (pătrate) mari cu valoarea respectivilor parametri. Se 
procedează apoi la combinarea celor două fişiere printr-o operaţie algebrică de 
scădere din altitudinea maximă pe cea minimă, rezultând un fişier raster cu diferenţele 
respective de altitudine asemănător cu metoda cartogramei (a pătratelor).

Pentru a reprezenta densitatea fragmentării reliefului (densitatea reţelei de 
văi) se construieşte mai întâi fişierul vector cu reţeaua de văi. Se converteşte acesta 
într-un raster binar, apoi se aplică un SML care calculează lungimea reţelei în 
interiorul unui pătrat cu latura de 1 km, rezultând reţeaua de pixeli cu valorile 
densităţii fragmentării.

Prin utilizarea limbajului de programare SML se pot face interogări asupra 
rasterelor rezultate. Se obţin astfel hărţi clasificate ale hipsometriei, pantelor, 
expoziţiei versanţilor, adâncimii fragmentării şi densităţii fragmentării.

Algoritmul de lucru pentru realizarea decupajelor statistice din hărţile 
realizate pentru fiecare bazin hidrografic în parte cuprinde realizarea stratului cu 
bazinele hidrografice şi extragerea informaţiilor statistice corespunzătoare fiecărui 
bazin hidrografic. Mai întâi se realizează un fişier vectorial care să conţină poligoane 
reprezentând cumpenele de apă ale bazinelor hidrografice, în meniul Edit al 
programului TNT Mips. Delimitarea bazinelor hidrografice s-a făcut direct pe 
calculator de pe hărţile topografice la scara 1:25.000.

Fişierul cu bazinele hidrografice poate fi generat şi automat, procesând MNT-
ul întregii regiuni în meniul Process → Raster → Elevation → Watershed, de unde 
rezultă o serie de fişiere raster şi vector care reprezintă mai mulţi parametri privind 
scurgerea superficială, între care şi unul cu bazinele hidrografice delimitate. În acest 
caz trebuie aduse însă corecţii pentru că liniile de delimitare urmăresc forma pătrată a 
pixelilor şi apar astfel erori în ceea ce priveşte perimetrul şi suprafaţa bazinelor
(figura 2). Este necesar ca modelul numeric al reliefului să fie realizat la o rezoluţie 
mai mare, iar liniile frânte în unghi drept rezultate prin trasarea automată a bazinelor 
hidrografice să fie simplificate (Line Simplification) cu un prag dimensional mai mare 

Fig. 1. Poziţia matematică a regiunii de studiu.
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decât rezoluţia pixelilor modelului digital altitudinal. Liniile trasate automat sunt 
astfel netezite rezutând o delimitare mai aproape de realitate cu erori minime. După 
aceste corecţii poligoanele arată ca în figura 3.

Fig. 2. Linii necorectate de delimitare automată 
a bazinelor hidrografice.

Fig. 3. Linii corectate de delimitare a bazinelor 
hidrografice.

Pentru exemplificare ne-am oprit la bazinele hidrografice afluente directe ale 
Siretului şi ale Bârladului (figura 4), însă detalierea poate continua până la bazinele 
de ordinul 1 (sistem Horton-Strahler) ale afluenţilor principali. În urma alegerii făcute 
au rezultat 43 de bazine hidrografice de diferite ordine.

Pentru analiza spaţială morfometrică a bazinelor hidrografice se pot alege 
două variante. Într-o primă variantă, rasterele corespunzătoare indicilor morfometrici 
sunt extrase după vectorul cu limitele bazinelor rezultând rastere mai mici cu 
informaţii despre bazinele corespunzătoare poligoanelor din fişierul vector. Fiecare 
bazin poate fi reprezentat cartografic şi analizat geomorfometric mai uşor atunci când 
este separat de celelalte bazine dintr-un areal mai larg, având fişiere distincte pentru 
fiecare bazin şi parametru supus analizei. În schimb, această variantă este mai 
laborioasă şi complică lucrul prin multitudinea de fişiere cu care se lucrează, atunci 
când se doreşte o analiză comparativă a morfometriei bazinelor hidrografice.

În al doilea mod, mai elegant, se ataşează fiecărui poligon atribute preluate 
din fişierele raster extrase direct din MNT (altitudinea, expoziţia, înclinarea terenului) 
sau derivate din acesta prin alte procese (adâncimea fragmentării şi densitatea 
fragmentării). Această procedură se aplică din meniul Process → Vector → Attributes 
→ Raster properties. Ca urmare, selectând în meniul Edit un poligon se va afişa în 
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tabelele de atribute linia corespunzătoare cu valorile caracteristice fiecărui indice 
geomorfometric. Tabelele pot fi salvate în format bază de date şi prelucrate în 
programul Microsoft Excel. În urma analizei statistice a bazinelor hidrografice din 
vestul Podişului Central Moldovenesc luate în studiu, vom face în continuare câteva 
comentarii.

Fig. 4. Bazinele hidrografice principale din regiunea studiată:

a) afluenţii Bârladului:
1 - Şacovăţ
2 - Găureanca
3 - Hăuş
4 - Rângoi
5 – Gârbovăţ
6 - Crăiasa
7 – Bozieni
8 – Mărmureni
9 - P. Oniceni
10 - V. Enei
11 - V. Ciocanului
12 - V. Giurgenilor
13 - V. Grădinarului
14 - V. Stuhuşor
15 - V. Arşiţei
16 - V. Ursului
17 - P. Cotu Popii

18 - V. Muncelului
19 - V. Gorunului
20 - V. Poiana Lungă
21 - V. Fundu Ocea
22 - V. Pustieta
23 - V. Băbuşa
24 - V. Păltinişului
25 - V. Iezerului
26 - V. Pietroasa
27 - Valea Mare
28 – Viişoara
29 - V. Plopoasa
30 - V. Mahalagiilor
31 - V. Olăşerului
32 - Valea Mare (Bristova)
33 – Buhăieşti
34 – Bîrzeşti
35 - Stemnic

b) afluenţii Siretului (de la nord la 
sud):
36 - Pârâul Pietros
37 - Valea Samson
38 – Ţiganca
39 - P. Recea
40 – Icuşeşti
41 - P. Spiridoneşti
42 – Glodeni
43 – Râpaş
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Altitudinea maximă absolută a bazinelor luate în studiu variază între 466 m 
(bazinul Crăiasa în Dealul Milişte) şi 250 m (bazinul Spiridoneşti), iar altitudinea 
minimă (punctele de confluenţă) variază între 97 m (la confluenţa Stemnicului cu 
Bârladul) şi 255 m (la obârşia Bîrladului). Diferenţele de nivel între obârşii şi 
punctele de confluenţă sunt mai mici la bazinele hidrografice mici, de ordin 1-3 
(Spiridoneşti – 82 m) şi mai mari la bazinele cu extindere mare, de ordin 4-5 (Stemnic 
– 367 m). Majoritatea bazinelor analizate se caracterizează printr-o amplitudine 
altitudinală de peste 200 m. Bazinele hidrografice mici descresc treptat în altitudine 
dinspre obârşii spre confluenţă. Înălţimile maxime ale bazinelor râurilor mai mari nu 
se înregistrează totdeauna în apropierea obârşiilor (sau în apropierea distanţei maxime 
de confluenţă) pentru că, în timp, au fragmentat liniile de înălţime maximă prin 
eroziunea regresivă, astfel că în prezent înălţimile mari sunt asociate unor dealuri cu 
profil mai mult sau mai puţin ascuţit, dispuse pe o direcţie  perpendiculară pe direcţia 
de scurgere a râurilor actuale. Aşa sunt, spre exemplu, cele suprapuse cumpenei de 
ape dintre bazinul Bârladului şi Bahluiului.

Altitudinea medie 
a bazinelor depăşeşte 200 
m, cu excepţia bazinului 
Văii Bârzeşti (194 m). Aşa 
cum ne aşteptăm 
altitudinea medie cea mai 
ridicată o întâlnim la 
bazinele mici din zona de 
obârşie a Bârladului (peste 
300 m). Faţă de altitudinea 
medie a întregii regiuni 
(242,5 m, ponderile 
suprafeţelor altitudinale 
parţiale sunt prezentate în 
figura 5), bazinele studiate 
prezintă o medie mai mare 
(269,3) pentru că s-au 
omis din analiza noastră o 
serie de bazine mici de 
ordinul 1 afluente directe ale Bârladului sau Siretului, cu altitudini ceva mai mici, 
precum şi bazinele Racovei, pârâului Valea Mare (Mora) şi Pârâului Morii, afluente 
mai aval de bazinele luate în consideraţie, doar parţial extinse în aria noastră de 
studiu. Majoritatea bazinelor prezintă altitudine medie cuprinsă între 230-310 m.

Altitudinea medie a regiunii studiate este de 242,5 m, mai mare decât în 
partea estică a Podişului Central Moldovenesc, iar ecartul altitudinal este de 373,2 m.
Clasa modală este cea de 250-300 m, cu o frecvenţă asemănătoare înscriindu-se şi 
clasa 200-250 m, majoritatea valorilor fiind cuprinse între 171 m şi 314 m. 
Altitudinile mari, de peste 300 m, apar cu o frecvenţă de 13,8 %, corespunzând unei 
suprafeţe de cca. 130 km2, din care cca. 30 km2 corespund unor altitudini mai mari de 
350 m.

Înclinarea terenului (pantele reliefului) a fost determinată automat pe baza 
modelului numeric al altitudinii, fiind aplicată ulterior o clasificare, în urma căreia au 
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Fig. 5. Ponderea suprafeţelor altitudinale parţiale din Podişul 
Central Moldovenesc dintre Siret şi Şacovăţ.
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rezultat 7 clase de valori cu relevanţă geomorfologică (tabelul 1). Panta maximă 
calculată automat de programul SIG este 36°54’, panta medie a regiunii de studiu este 
de 6°42’, iar deviaţia standard de 4°36’, de unde rezultă că majoritatea valorilor sunt 
cuprinse între 2°06’ ÷ 11°18’, valori care indică un tip de fragmentare a terenului care 
determină prezenţa unor suprafeţe întinse relativ orizontale mărginite de versanţi cu 
înclinare foarte mare, evoluţie a reliefului care argumentează denumirea de podiş dată 
regiunii.

Tab. 1. Situaţia statistică a claselor de pantă (în grade) pe întreg cuprinsul Podişului Central 
Moldovenesc dintre Siret şi Şacovăţ.

Clasa Pondere procentuală Suprafaţa (km2)
<1 10,38 160.79
1-3 15,21 235.61
3-5 14,19 219.81
5-10 37,77 585.09

10-15 17.83 276.20
15-20 3,74 57.94
>20 0,88 13.63

Total 100,00 1549.07

Tab. 2. Bazinele hidrografice cu pantele medii cele mai mari (în grade).

Bazinul hidrografic Confluentul Panta 
medie

Panta 
maximă

Stemnic Bârlad 8.2 36.2
Mărmureni Bârlad 8.4 25.7
Valea Gorunului Bârlad 8.4 29.5
Pârâul Cotu Popii Bârlad 8.7 25.2
Valea Mare Bârlad 9.0 27.4
Valea Pietroasă Bârlad 9.1 27.2
Valea Plopoasa Bârlad 9.2 35.6
Valea Iezerului Bârlad 9.4 26.6
Valea Mahalagiilor Bârlad 9.5 32.6
Valea Poiana Lungă (Pietrosu) Bârlad 9.6 31.1
Valea Mare (Bristova) Bârlad 9.7 31.7
Valea Băbuşa Bârlad 9.9 31.1
Valea Păltinişului Bârlad 9.9 26.6
Valea Viişoara Bârlad 10.0 23.1
Valea Olăşerului Bârlad 10.1 26.6
Valea Fundu Ocea Bârlad 10.1 30.7
Valea Pustieta Bârlad 10.9 30.8

Faţă de valorile prezentate există diferenţe la nivelul bazinelor hidrografice. 
Astfel pante maxime de peste 30° se întâlnesc în bazinele Gârbovăţ, Crăiasa, Şacovăţ, 
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Bozieni, Icuşeşti ş.a., pe versanţii cuestiformi, însă panta medie a acestora se situează 
în jurul valorii de 7°. Se remarcă în acest sens bazinul pârâului Icuşeşti (figura 6), 
care prezintă o asimetrie frapantă în ceea ce priveşte înclinarea reliefului: pante 
maxime de peste 30° pe versantul stâng al pârâului (cu o maximă de cca. 36°) în timp 
ce versantul drept corespunzător unui revers de cuestă prezintă pante foarte reduse 
Pante medii foarte mari caracterizează bazinele mai mici, de ordin 2, din Coasta 
Bârladului: Valea Pustieta, Valea Fundu Ocea, Valea Olăşerului şi Valea Viişoara 
(tabelul 2).

Fig. 6. Harta hipsometrică a bazinului hidrografic Icuşeşti.

Fig. 7. Harta pantelor din bazinului hidrografic Icuşeşti.
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Structura geologică monoclinală a impus orientarea şi evoluţie reţelei 
hidrografice spre crearea unor bazine asimetrice. Şi din acest punct de vedere se pun 
în evidenţă asimetrii, în special în cadrul bazinelor mai mari, cu văi subsecvente cel 
puţin pe anumite sectoare. De asemenea, afluenţii de pe stânga Siretului şi-au creat 
bazine asimetrice. În figura 6 este prezentată hipsometria bazinului Icuşeşti, iar în 
figura 7 harta pantelor pentru acelaşi bazin.

Ca o caracteristică a acestei regiuni, chiar unele văi reconsecvente prezintă 
bazine asimetrice. În aceste cazuri se pun în evidenţă cueste cu alte orientări decât 
cele clasice (orientate general spre nord-vest). Acest lucru a fost arătat şi de I. Ioniţă 
în lucrarea sa privitoare la relieful de cueste din Podişul Moldovei (2000), explicând 
asimetria de ordinul II prin componenta vest-est a înclinării straturilor de roci.

Bazinele hidrografice mici sunt în general simetrice, dar apar şi excepţii în 
situaţia unor afluenţi subsecvenţi (valea Piscul Rusului) sau atunci când, pe fondul 
unor condiţii locale de înclinare a straturilor de roci, s-au format şi bazine asimetrice 
reconsecvente sau chiar obsecvente. Dintre văile reconsecvente asimetrice se remarcă 
cele din bazinul pârâului Ţiganca (Valea Chiricel, Valea Avereşti, Valea David), 
reprezentat din punct de vedere hipsometric în figura 8 şi a cărui înclinare a terenului 
este reprezentată în figura 9.

Fig. 8. Harta hipsometrică a bazinului hidrografic Ţiganca.

Văi obsecvente asimetrice s-au format pe fondul aceleiaşi înclinări a 
straturilor de roci către est, aşa cum este cazul unor afluenţi ai Şacovăţului superior, 
amonte de Mădârjac (figura 10). Deşi înclinarea generală a straturilor de roci este 
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dinspre nord-vest către sud-est, este posibil ca, local, datorită condiţiilor de 
sedimentare din mediul marin sarmatic (conuri de depunere a aluviunilor, bare 
datorate unor curenţi marini), înclinarea straturilor de roci să fie spre alte direcţii 
decât cea generală.

Fig. 9. Harta pantelor din bazinului hidrografic Ţiganca.

Orientarea (expoziţia) versanţilor este o consecinţă a evoluţiei reţelei 
hidrografice pe fondul structurii geologice monoclinale cu o cădere generală a 
straturilor geologice de suprafaţă de la nord-vest spre sud-est. Pe ansamblul regiunii, 
versanţii cu orientare nord-estică, sud-vestică şi estică, vestică, corespunzători primei 
categorii de văi, cumulează o frecvenţă de apariţie de 65,9 %, valorile cele mai mari 
fiind asociate expoziţiilor sud-vestice (20,4 %) şi estice (18,2 %). Versanţii cu 
orientare nord-vestică, sud-estică, nordică şi sudică, corespunzători celei de-a doua 
categorii de văi, apar cu o frecvenţă mult mai redusă (26,4%), valorile cele mai mici 
fiind asociate expoziţiilor nordice (3,4 %) şi nord vestice (4,5 %). Terenurile cvasi-
orizontale (luncile şi terasele râurilor, platourile structurale), în cazul cărora nu se 
poate vorbi despre o anumită expoziţie, cumulează o pondere de 7,7 %.

Apar însă diferenţieri la nivelul bazinelor hidrografice, în funcţie de direcţia 
generală de scurgere a reţelei hidrografice. Afluenţii Bârladului superior sunt dispuşi 
în evantai, astfel că cei de pe stânga au o direcţie de scurgere în general consecventă, 
iar cei de pe dreapta, până aval de Negreşti au format văi obsecvente grefate pe 
Coasta Bârladului. Din acest motiv predomină expoziţia nord-estică şi estică, 
respectiv, sud-vestică şi vestică. La afluenţii Siretului, care prezintă văi subsecvente, 
predomină expoziţia nordică şi nord-vestică, pe o parte a văilor, şi sudică şi sud-
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Fig. 10. Hipsometria regiunii afluenţilor asimetrici de pe dreapta Şacovăţului amonte de 
Mădârjac.

Adâncimea fragmentării reliefului a fost determinată prin suprapunerea 
unei grile pătratice, cu dimensiunea laturii ochiurilor de 1 km, peste modelul numeric 
al altitudinii terenului. Pentru fiecare pătrat s-au extras automat valorile altitudinii 
maxime şi minime în două fişiere distincte, după care s-a făcut diferenţa lor într-un 
fişier raster care a fost clasificat în 5 clase de valori.

Valoarea medie a adâncimii fragmentării reliefului din regiunea de studiu este 
de cca. 99 m, valorile oscilând între 1 m şi 241 m. Deviaţia standard este de 34,4 m 
ceea ce arată că marea majoritate a valorilor sunt situate în intervalul 65-133 m.

Valori reduse ale energiei de relief (sub 10 m) sunt caracteristice mai ales 
luncilor mari (ale Siretului, Bârladului, Şacovăţului, Stemnicului şi Racovei), iar 
valorile mari, de peste 150 m, sunt specifice fronturilor cuestelor principale, în special 
coasta Bârladului (figura 11). Valoarea maximă de 241 m este întâlnită în cuestele 
principale, local putând depăşi chiar 300 m, de secţionarea acestor sectoare fiind de 
vină decupajul arbitrar realizat de grila pătratică ce nu a permis evidenţierea acestor 
valori.

O metodă de determinare a acestui indice prin care s-ar evidenţia energia 
râului este cea prin care se calculează diferenţa altitudinală dintre fiecare punct al 
bazinului şi talvegul cel mai apropiat. Metoda poate da erori în cazul unor puncte 
apropiate de talveguri ale bazinelor hidrografice vecine. O variantă mai aproape de 
realitate este cea prin care se calculează amplitudinea altitudinală maximă din 
interiorul bazinului hidrografic la lungimea profilului longitudinal al râului. În acest 
caz denumirea de energie de relief se justifică pentru că este vorba despre o diferenţă 
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altitudinală locală determinată pe o unitate corespunzând unei realităţi 
geomorfologice – bazinul hidrografic, iar altitudinile sunt calculate faţă de un nivel de 
bază real – talvegul unui râu.

Bazinele hidrografice afluente ale Bârladului prezintă valorile cele mai mari 
ale acestui indice morfometric. Se remarcă bazinul Şacovăţului care deţine valoarea 
maximă şi bazinele mici de pe dreapta Bârladului (tabelul 3).

Tab. 3. Bazinele hidrografice cu adâncimea fragmentării maximă cea mai mare.

Bazinul hidrografic Confluentul
Partea 

de 
afluenţă

Adâncimea 
fragmentării 
maximă (m)

Şacovăţ Bârlad Stg 211
Stemnic Bârlad Dr 209
Valea Pietroasă Bârlad Dr 207
Valea Mahalagiilor Bârlad Dr 198
Valea Băbuşa Bârlad Dr 192
Valea Păltinişului Bârlad Dr 189
Pârâul Pietros Siret Stg 186
Gârbovăţ Bârlad Stg 183
Valea Olăşerului Bârlad Dr 180

Fără excepţie, adâncimea fragmentării medie prezintă cele mai mari valori în 
bazinele mici afluente ale Bârladului dinspre Coasta Bârladului (tabelul 4).

Tab. 4. Bazinele hidrografice cu adâncimea fragmentării medie cea mai mare.

Bazinul hidrografic Confluentul Partea de 
afluenţă

Adâncimea fragmentării 
medie (m)

Valea Fundu Ocea Bârlad Dr 150
Valea Pustieta Bârlad Dr 148
V. Băbuşa Bârlad Dr 148
Valea Iezerului Bârlad Dr 143
Valea Pietroasă Bârlad Dr 141
V. Mahalagiilor Bârlad Dr 141
Valea Olăşerului Bârlad Dr 140
V. Păltinişului Bârlad Dr 137
Viişoara Bârlad Dr 136
Valea Mare (Bristova) Bârlad Dr 135
P. Cotu Popii Bârlad Dr 132
V. Poiana Lungă (Pietrosu) Bârlad Dr 131
Valea Mare Bârlad Dr 130
V. Plopoasa Bârlad Dr 128
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Fig. 11. Podişul Central Moldovenesc dintre Siret şi Şacovăţ. Harta adâncimii fragmentării 
reliefului.

Densitatea fragmentării reliefului pentru întreg arealul studiat a fost 
calculată prin metoda cartogramei, determinându-se lungimea totală a reţelei de văi 
din fiecare pătrat având suprafaţa de 1 km2. Ponderile claselor de valori pe întreg 
arealul sunt prezentate în tabelul 5.

Tab. 5. Situaţia statistică a claselor de densitate a fragmentării reliefului.

Clasa Ponderea procentuală Suprafaţa (km2)
< 0,5 km/km2 4.2 65.05
0,5 – 1,0 km/km2 17.2 266.44
1,0 – 1,5 km/km2 38.5 596.40
1,5 – 2,0 km/km2 28.7 444.60
2,0 – 2,5 km/km2 9.3 144.06
2,5 – 3,0 km/km2 1.8 27.88
> 3,0 km/km2 0.3 4.64
Total 100.0 1549.07
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Fig. 12. Harta densităţii fragmentării reliefului.

Valoarea medie a densităţii fragmentării este 1,4 km/km2 iar intervalul maxim 
de variaţie este 0 – 4,33 km/km2. Deviaţia standard este de 0,8 km/ km2, ceea ce 
indică un interval cuprins între 0,6 – 2,0 km/km2 în care sunt încadrate majoritatea 
valorilor. Valorile reduse (sub 0,5 km/km2) cumulează o frecvenţă de apariţie foarte 
mică (4,2 %), fiind caracteristice mai ales culmilor interfluviale. Valorile din 
intervalul 1,0 – 1,5 km/km2 se înscriu cu frecvenţa cea mai mare (38,5 %, fiind 
urmate de cele cuprinse între 1,5 – 2,0 km/km2 (28,7 %). Valorile densităţii 
fragmentării mai mari caracterizează, mai ales, zonele de confluenţă ale văilor de la 
baza unor versanţi cuestiformi.

Cele mai mari valori ale acestui indice (maxime de peste 3,5 km/km2) se 
întâlnesc la confluenţa văilor din bazinele Crăiasa, Şacovăţ, Gârbovăţ, Stemnic, 
Râpaş şi Ţiganca (tabelul 6). Însă valorile medii cele mai mari caracterizează bazinele 
hidrografice mici de pe dreapta Bârladului (tabelul 7).
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Tab. 6. Bazinele hidrografice cu densitatea fragmentării maximă cea mai mare.

Bazinul hidrografic Confluentul
Densitatea 

fragmentării maximă
(km/km2)

Crăiasa Bârlad 4,2
Râpaş Siret 3,9
Ţiganca Siret 3,8
Şacovăţ Bârlad 3,8
Gârbovăţ Bârlad 3,7
Stemnic Bârlad 3,6
Valea Mare Bârlad 3,3
Pârâul Pietros Siret 3,2
Valea Păltinişului Bârlad 3,2
Valea Samson Siret 3,1
Valea Poiana Lungă (Pietrosu) Bârlad 3,1
Valea Gorunului Bârlad 3,0
Buhăieşti Bârlad 3,0
Valea Iezerului Bârlad 3,0

Tab. 7. Bazinele hidrografice cu densitatea fragmentării medie cea mai mare.

Bazinul hidrografic Confluentul Densitatea fragmentării 
medie (km/km2)

Pârâul Cotu Popii Bârlad 2,0
Valea Samson Siret 1,8
Valea Mahalagiilor Bârlad 1,8
Valea Ursului Bârlad 1,7
Valea Muncelului Bârlad 1,6
Valea Poiana Lungă (Pietrosu) Bârlad 1,6
Valea Mare (Bristova) Bârlad 1,6
Pârâul Pietros Siret 1,6
Valea Stuhuşor Bârlad 1,6
Valea Gorunului Bârlad 1,6

Cele mai mici valori medii (sub 1,2 km/km2) caracterizează bazinele 
hidrografice Mărmureni, Oniceni şi Bârzeşti, din bazinul Bârladului, şi Spiridoneşti, 
Icuşeşti şi Glodeni, dintre afluenţii Siretului.

În concluzie, aplicarea SIG în studiul morfometriei bazinelor hidrografice 
permite analiza spaţială detaliată a indicilor morfometrici, punându-se în evidenţă mai 
multe aspecte privind evoluţia reliefului în raport cu factorii morfogenetici. Indicii 
morfometrici beneficiază de reprezentarea cea mai fidelă în cadrul programelor SIG 
dacă se aleg parametrii de calcul şi de reprezentare optimi.
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În urma analizei bazinelor hidrografice din vestul Podişului Central 
Moldovenesc se pot desprinde următoarele concluzii privind distribuţia spaţială a 
indicilor geomorfometrici:

- altitudinea medie a bazinelor hidrografice depinde de ordinul acestora: cele 
mai mari altitudini caracterizează bazinele hidrografice mici din zonele de obârşie 
situate de-a lungul Culmii Siretului;

- pantele mari caracterizează versanţii cuestiformi ai văilor, în cadrul cărora 
se înregistrează şi adâncimea fragmentării maximă;

- densitatea fragmentării cea mai mare se înregistrează în zonele de 
confluenţă de la baza unor versanţi cuestiformi, aşa cum este spre exemplu Valea 
Bârladului, care primeşte de pe dreapta numeroşi afluenţi;

- în cadrul tuturor bazinelor hidrografice de ordin 3 sau mai mare se remarcă 
o frapantă asimetrie din punct de vedere al parametrilor geomorfometrici, determinată 
de structura geologică monoclinală generală; chiar şi unele bazine hidrografice mici 
prezintă asimetrie datorată condiţiilor locale de structură geologică.
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